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Chapter 166

Equivalence Tests for the
Ratio of Two Correlated
Proportions
Introduction
The procedure described in this chapter compute power and sample size for testing equivalence using ratios in
designs in which two dichotomous responses are measured on each subject.
When one is interested in showing that two correlated proportions are different, the data are often analyzed with
McNemar’s test. However, the procedures discussed here are interested in showing equivalence rather than
difference. For example, suppose a diagnostic procedure is accurate, but is expensive to apply or has serious side
effects. A replacement procedure may be sought which is equally accurate, but is less expensive or has fewer side
effects. In this case, we are not interested in showing that the two diagnostic procedures are different, but rather
that they are the same. Equivalence tests were designed for this situation.
These tests are often divided into two categories: equivalence (two-sided) tests and non-inferiority (one-sided)
tests. Here, the term equivalence tests means that we want to show that two diagnostic procedures are
equivalent—that is, their accuracy is about the same. This requires a two-sided hypothesis test. On the other hand,
non-inferiority tests are used when we want to show that a new (experimental) procedure is no worse than the
existing (reference or gold-standard) one. This requires a one-sided hypothesis test.

Technical Details
The results of a study in which two dichotomous responses are measured on each subject can be displayed in a 2by-2 table in which one response is shown across the columns and the other is shown down the rows. In the
discussion to follow, the columns of the table represent the standard (reference or control) response and the rows
represent the treatment (experimental) response. The outcome probabilities can be classified into the following
table.

Experimental Standard Diagnosis
Diagnosis
Yes
No
Yes

p11

p10

No
Total

p01
PS

p00
1 − PS

Total
PT
1 − PT
1

In this table, pij = pTreatment , Standard . That is, the first subscript represents the response of the new, experimental
procedure while the second subscript represents the response of the standard procedure. Thus, p01 represents the
proportion having a negative treatment response and a positive standard response.
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Sensitivity, Specificity, and Prevalence
To aid in interpretation, analysts have developed a few proportions that summarize the table. Three of the most
popular ratios are sensitivity, specificity, and prevalence.

Sensitivity
Sensitivity is the proportion of subjects with a positive standard response who also have a positive experimental
response. In terms of proportions from the 2-by-2 table,
Sensitivity = p11 / ( p01 + p11 ) = p11 / PS

Specificity
Specificity is the proportion of subjects with a negative standard response who also have a negative experimental
response. In terms of proportions from the 2-by-2 table,
Specificity = p00 / ( p10 + p00 )

Prevalence
Prevalence is the overall proportion of individuals with the disease (or feature of interest). In terms of proportions
from the 2-by-2 table,
Prevalence = PS

Table Probabilities
The outcome counts from a sample of n subjects can be classified into the following table.

Experimental Standard Diagnosis
Diagnosis
Yes
No
Total
Yes
n11
n10
nT
No
n01
n00
n − nT
Total
nS
n − nS
n
Note that n11 + n00 is the number of matches (concordant pairs) and n10 + n01 is the number of discordant pairs.
The hypothesis of interest concerns the two marginal probabilities PT and PS . PS represents the accuracy or
success of the standard test and PT represents the accuracy or success of the new, experimental test. Equivalence
is defined in terms of either the difference, D = PT − PS , or the relative risk ratio, R = PT / PS , of these two
proportions. The choice between D and R will usually lead to different sample sizes to achieve the same power.
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Equivalence Hypotheses using Ratios
For the two-sided (equivalence) case when RE < 1 , the statistical hypotheses are

H 0 : PT / PS ≤ 1 / RE or PT / PS ≥ RE

versus

H1: RE < PT / PS < 1 / RE

These can be decomposed into two sets of one-sided hypotheses

H 0 L : PT / PS ≤ RE

versus

H1L : PT / PS > RE

H 0U : PT / PS ≥ 1 / RE

versus

H1U : PT / PS < 1 / RE

and

Note that the first set of one-sided hypotheses, H0L versus H1L, is referred to as the hypotheses of non-inferiority.
The following is based on Nam and Blackwelder (2002). We refer you to this paper for the complete details of
which we will only provide a brief summary here.

Test Statistics
The test statistic for an asymptotic test based on constrained maximum likelihood for large n is given by

Z ( RE ) =

(

)

n PT − RE PS
R (~
p +~
p )
E

10

01

where

~
p10 =

(

) ( P − R P )

− PT + RE2 PS + 2 p10 +

T

2
E S

2

+ 4 RE2 p10 p 01

2 RE ( RE + 1)

~
p10 − ( RE − 1)(1 − p 00 )
p01 = RE ~

p 01 =

n +n
n +n
n01
n
, p10 = 10 , PT = 10 11 , PS = 01 11
n
n
n
n

Note that the above applies to a one-sided test. When using a two-sided test, we calculate both Z ( RE ) and

Z (1/ RE ) using the above formula.

Power Formula
The power of the one-sided procedure when the true value of the relative risk ratio is RE can be evaluated exactly
using the multinomial distribution. When n is large, we use a normal approximation to the multinomial
distribution which leads to

β ( RA ) = Φ (cU )
where

cU =

z1−α V0 (T0 ) − E1 (T0 )

V0 (T0 ) =

V1 (T0 )
RE ( p10 + p01 )
n
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E1 (T0 ) = ( RA − RE ) PS

(R
V (T ) =
1

A

)

+ RE2 PS − 2 RE p11 − ( RA − RE ) PS2
2

0

p10 =

n

− PT + RE2 ( PS + 2 p10 ) +

(P − R P )
T

2
2
E S

+ 4 RE2 p10 p01

2 RE ( RE + 1)

p01 = RE p10 − ( RE − 1)(1 − p00 )

Nuisance Parameter
Unfortunately, the 2-by-2 table includes four parameters p11 , p10 , p01 , and p00 , but the power specifications
above only specify two parameters: PS and DA or RA . A third parameter is defined implicitly since the sum of
the four parameters is one. One parameter, known as a nuisance parameter, remains unaccounted for. This
parameter must be addressed to fully specify the problem. This fourth parameter can be specified by specifying
any one of the following: p11 , p10 , p01 , p00 , p10 + p01 , p11 + p00 , or the sensitivity of the experimental response,
p11 / PS .
It may be difficult to specify a reasonable value for the nuisance parameter since its value may not be even
approximately known until after the study is conducted. Because of this, we suggest that you calculate power or
sample size for a range of values of the nuisance parameter. This will allow you to determine how sensitive the
results are to its value.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power or Sample Size.
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Power Calculation
Power Calculation Method
Select the method to be used to calculate power.
The choices are
•

Multinomial Enumeration
Power is computed using multinomial enumeration of all possible outcomes when N ≤ Max N for
Multinomial Enumeration (otherwise, the normal approximation is used). Multinomial enumeration of all
outcomes is possible because of the discrete nature of the data.

•

Normal Approximation
Approximate power is computed using the normal approximation to the multinomial distribution.

The exact calculation using the multinomial distribution becomes very time consuming for N > 500. When N >
500, the difference between the multinomial and approximate calculations is small.
For small values of N (less than 100), the Multinomial Enumeration power may be overly optimistic because the
discrete nature of the trinomial distribution results in the actual alpha value being higher than its target. To be on
the safe side, we recommend that you use the approximate calculation.
Max N for Multinomial Enumeration
Only shown when Power Calculation Method = “Multinomial Enumeration”
Specify the maximum value of N (sample size) that uses the exact power calculation based on the multinomial
distribution. N's greater than this value will use the asymptotic approximation.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when you fail to conclude
equivalence when in fact it is true.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. Here, a type-I error occurs when you falsely conclude equivalence.

Sample Size
N (Sample Size)
Enter a value for the sample size. This value must be greater than two. You may enter a range of values such as 10
to 100 by 10.
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Effect Size – Ratios
Re (Equivalence Ratio)
Re is the minimum size of the relative risk ratio, PT / PS , that will still result in the conclusion of equivalence.
Equivalence trials use a value that is less than one. Typical values for this ratio are 0.8 or 0.9.
Ra (Actual Ratio)
Enter a value for Ra, the actual relative risk ratio PT / PS . This value is used to generate the value of PT using the
formula PT = PS Ra . Often this value is set equal to one, but this is not necessary.

Effect Size – Standard Proportion
Ps (Standard Proportion)
This is the proportion of yes’s (or successes), PS , when subjects received the standard treatment. This value or a
good estimate is often available from previous studies.
Note that this value does not matter when the Nuisance Parameter Type is set to “P01” (or “P10”), as long as it is
greater than P01 (or P10).
You may enter a set of values separated by blank spaces. For example, you could enter 0.50 0.60 0.70. Values
between, but not including, 0 and 1 are permitted.

Effect Size – Nuisance Parameter
Nuisance Parameter Type
Enter the type of nuisance parameter here. Unfortunately, the 2-by-2 table cannot be completely specified by
using only the parameters Ps and Da or Ps and Ra. One other parameter must be specified. This additional
parameter is called a “nuisance” parameter. It will be assumed to be a known quantity. Several possible choices
are available. This option lets you specify which parameter you want to use. In all cases, the value you specify is a
proportion.
•

P11 (% Positive Matches)
The proportion of subjects that are positive on both tests.

•

P00 (% Negative Matches)
The proportion of subjects that are negative on both tests.

•

P01 (% -Trt +Std)
The proportion of subjects that are negative on the treatment, but positive on the standard.

•

P10 (% +Trt -Std)
The proportion of subjects that are positive on the treatment, but negative on the standard.

•

P11+P00 (% Matches)
The proportion of matches (concordant pairs).

•

P01+P10 (% Disagree)
The proportion of non-matches (discordant pairs).

•

P11/Ps (Sensitivity)
The sensitivity.
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Nuisance Parameter Value
Enter the value of the nuisance parameter that you specified in the “Nuisance Parameter Type” box. This value is
a proportion, so it must be between 0 and 1.

Example 1 – Finding Power
A clinical trial will be conducted to show that a non-invasive MRI test is equivalent to the invasive CTAP
reference test. Historical data suggest that the CTAP test is 80% accurate. After careful discussion, the researchers
decide that if the ratio of the MRI test accuracy to the CTAP accuracy is at least 95% it will be considered
equivalent. They decide to use a ratio test statistic. Thus, the equivalence ratio is 0.95. They want to study the
power for various sample sizes between 200 and 1000 at the 5% significance level.
They use P01 as the nuisance parameter and look at two values: 0.05 and 0.10.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Ratio of Two Correlated Proportions procedure window by
expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking
on Equivalence Tests for the Ratio of Two Correlated Proportions. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Alpha ....................................................... 0.05
N (Sample Size)...................................... 200 300 450 600 800 1000
Re (Equivalence Ratio) ........................... 0.95
Ra (Actual Ratio) .................................... 1.0
Ps (Standard Proportion) ........................ 0.80
Nuisance Parameter Type ...................... P01 (% -Trt +Std)
Nuisance Parameter Value ..................... 0.05 0.10
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Equivalence (Two-Sided) Test of a Ratio
Sample
Size
Power
N
0.06511
200
0.00000
200
0.37821
300
0.00000
300
0.68145
450
0.21499
450
(report continues)

Equiv.
Ratio
Re
0.950
0.950
0.950
0.950
0.950
0.950

Actual
Ratio
Ra
1.000
1.000
1.000
1.000
1.000
1.000

Treatment Standard
Proportion Proportion
Pt
Ps
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800
0.800

Nuisance
Parameter
P01
0.050
0.100
0.050
0.100
0.050
0.100

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

* Power was computed using the normal approximation method.
Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the number of subjects, the sample size.
Re is the maximum ratio between Pt and Ps that is still called 'equivalent'.
Ra is the actual ratio between Pt and Ps. That is, Ra = Pt/Ps.
Pt is the response proportion to the treatment (experimental or new) test.
Ps is the response proportion to the standard (reference or old) test.
The Nuisance Parameter is a value that is needed, but is not a direct part of the hypothesis.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
A sample size of 200 subjects achieves 6.511% power at a significance level of 0.050 using a
two-sided equivalence test of correlated proportions when the standard proportion is 0.800, the
maximum ratio of these proportions that still results in equivalence (the range of equivalence)
is 0.950, and the actual ratio of the proportions is 1.000.

This report shows the power for the indicated scenarios. All of the columns are defined in the “Report
Definitions” section.

Plots Section

These plots show the power versus the sample size for the two values of P01. In this example, we see that the
value of the nuisance parameter has a large effect on the calculated sample size.
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Example 2 – Finding Sample Size
Continuing with Example 1, the analysts want to determine the exact sample size necessary to achieve 90% power
for both values of the nuisance parameter.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Ratio of Two Correlated Proportions procedure window by
expanding Proportions, then Two Correlated Proportions, then clicking on Non-Inferiority, and then clicking
on Equivalence Tests for the Ratio of Two Correlated Proportions. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Re (Equivalence Ratio) ........................... 0.95
Ra (Actual Ratio) .................................... 1.0
Ps (Standard Proportion) ........................ 0.80
Nuisance Parameter Type ...................... P01 (% -Trt +Std)
Nuisance Parameter Value ..................... 0.05 0.10

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Equivalence (Two-Sided) Test of a Ratio

Power
0.90046
0.90025

Sample
Size
N
688
1310

Equiv.
Ratio
Re
0.950
0.950

Actual
Ratio
Ra
1.000
1.000

Treatment Standard
Proportion Proportion
Pt
Ps
0.800
0.800
0.800
0.800

Nuisance
Parameter
P01
0.050
0.100

Alpha
0.050
0.050

* Power was computed using the normal approximation method.

This report shows that the sample size required nearly doubles when P01 is changed from 0.05 to 0.10.
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Example 3 – Validation
We could not find a validation example for an equivalence test for the ratio of two correlated proportions. The
calculations are basically the same as those for a non-inferiority test of the ratio of two correlated proportions,
which has been validated using Nam and Blackwelder (2002). We refer you to Example 3 of Chapter 161, “NonInferiority Tests for the Ratio of Two Correlated Proportions,” for a validation example.
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